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Installation
What's first?

The very first thing is to make sure that all support files for Enveloper are in the same 
directory as this document (ENVR4.HLP, ENVR4TPL.SKE, SAMPLE.ENV, ZIP*.*).

The table of envelope icons on the first page of the ENVR4.DOC are pictoral representations 
of the envelope position in a feeder tray.    Recommendations are given for common printers,
although more than one can apply to some printers.    Choose the one that matches your 
printer, double-click it, and you're on your way!

You can also start the installation by double-clicking the red, double-bordered macrobutton 
at the top of the document.    You then have to manually select your feed characteristics.    
You need to select your page orientation, envelope feed side, envelope flap side, and 
envelope facing side during feeding.    Choose Printer Selection for more hints.

CAUTION: If you are performing a reinstall, you may need to re-customize your envelopes.

What Comes Next?

The installation process will take you through a series of dialog boxes asking for your more 
information before it proceeds with the actual installation.    During installation, keep an eye 
on the Status Bar for progress of the installation.

1. If you chose a Reverse Landscape orientation, you will be asked if you have an
HP LaserJet III series printer with PCL5 or a PostScript printer (including those 
with PostScript cartridges) to determine if you need to imbed special codes 
into your envelopes to support Reverse Landscape.

2. You will be prompted for the unit of measurement you would like to use with 
Enveloper.    Choose Inches or Centimeters.

3. Next, you will be asked for the location you would like your envelope 
templates stored.    See Envelope Template Directory for more details.

4. You will be asked which type of fonts to use to print POSTNET bar codes.    See 
POSTNET Bar Code Fonts for more details on selection criteria.    You do not 
have to install any custom fonts now, you can install them later with Control 
Panel Fonts utility or ATM's Control Panel.

5. It will be a minute or two before the installer is finished.    Upon completion, 
you will be asked if you would like to print a sample envelope.    If you choose 
yes to print a sample on a regular piece of paper from your default tray.

6. You will be asked if you want to customize Enveloper.    If you choose Yes, you
can follow the steps to create a brand new envelope.

Choose one of the following for more detailed installation instructions:

Printer Selection
Reverse Landscape
Envelope Template Directory
POSTNET Bar Code Fonts
Creating a New Envelope





Printer Selection
HP LaserJets

LaserJet IIID and IIISi users should choose the "LaserJet Series" icon.    LaserJet IIIP has 
different feed characteristics, so it has its own selection.    If you have a PostScript cartridge, 
follow the PostScript Printer instructions.

PostScript Printers

Users of printer with PostScript cartridges should choose the icons marked "PostScript".    
There are several choices for PostScript, you'll have to decide which one is right for you.    In 
general, IIP and IIIP users with PostScript should choose "Flush Right" printing, while LJII 
series (II and IID) and LJIII series (III, IIID, IIISi) should choose "Center Feed" printing.

Portrait Orientation

If you chose a Portrait Orientation for printing envelopes, you'll be presented with an 
addition dialog box asking whether you want the envelope to align at the Top, Center or 
Bottom of the page.

Choose Top for printing envelopes on most printers.    Choose Center or Bottom for creating 
flyers that you want to mail.    For example, just choose Bottom, create your envelopes on 
your flyers, fold it, add stamp, and mail!    Professional looking, isn't it?

Related Topics:

Reverse Landscape
Envelope Template Directory
POSTNET Bar Code Fonts



Revese Landscape

What is it?

Reverse Landscape printing minimizes smudging by allowing the return address to be 
printed first.    For laser printers, this is possible only if you have a printer that uses the PCL5 
or PostScript printer language.    PCL5 is new for the HP LaserJet III series printers (including 
IIIP).

Since WinWord does not support directly Reverse Landscape printing, Enveloper imbeds the
printer codes directly into the envelope.    This is done with Print Fields.    Since PCL5 and 
PostScript are different languages, different printer codes needs to be entered for the 
printers.    That's why the installer asks you which kind of printer you have.

To make matters more confusing for PostScript users, Windows 3.0 does print in Reverse 
Landscape automatically.    Windows 3.1 does not.    The installer will detect automatically 
whether the codes are necessary.

Do I need it?

No, but you might want to try it if your return address is being smudged.    Standard control 
codes are provided for switching the printer orientation for PCL5 and PostScript printer.

How do I know if it's enabled?

Reverse Landscape printing is being used if your envelopes come out the printer witth the 
return address as the first item.

Related Topics:

Printer Selection
Envelope Template Directory
POSTNET Bar Code Fonts



Envelope Template Directory

Recommendation

It is recommended that you keep your envelopes in a separate directory to avoid confusion 
with your other WinWord files.    The default directory is a subdirectory beneath one you use 
for your WinWord templates (.DOT).    You can change it to anything else you like.

If the directory does not exist, it will be created.

Related Topics:

Printer Selection
Reverse Landscape
POSTNET Bar Code Fonts



POSTNET Bar Code Fonts

Which Option to Choose?

There several different ways to print POSTNET bar codes for your envelopes.    The only 
reason for the installation dialog box is to determine which method to use.    Please follow 
the following criteia:

1. If you have Windows 3.1, use TrueType fonts.    Even if you are using ATM, 
choose this option.

2. If you have ATM, choose the ATM fonts.    This is true no matter what kind of 
printer you have (including dot-matrix).

3. If you do not have either of the above, but do have a PostScript printer, 
choose the PostScript Type 1 fonts.    You'll also be asked which screen fonts to 
install.

4. If you have none of the above, choose the last button.    Enveloper will use 
the MSLineDraw font that came with WinWord 2.0 to create the bar codes.

Adding Fonts Later

You do not need to reinstall Enveloper to change the type of fonts you're using for the bar 
codes.    You can use the "Fonts" utility from "Control Panel" to add/delete TrueType and 
Screen fonts.    You can use ATM's control panel to add/remove ATM fonts.

Related Topics:

Printer Selection
Reverse Landscape
Envelope Template Directory



Running Enveloper
How To

You run Enveloper by clicking the envelope icon in the Toolbar or by selecting "Enveloper4" 
from the "Tools" menu.    (If you got here by clicking on Help, you knew that already.)

Enveloper tries to grab the addressee from your envelope in four ways:

1. Use the selection that you've highlighted, or...

2. If you have a bookmark called "NameAddress", use the text assigned to that 
bookmark, or...

3. Using one of the following algorithms for finding the addressee in your letter:

Microsoft's Grab
Smart Grab
SkipLines

None of them are fool proof.    Microsoft's Grab is the fastest and the default.    
If it doesn't work for you, try one of the others by changing Global Defaults.

4. If all of the above fails to grab an address, Enveloper will present you with an
input box for you to type one in manually.

After grabbing an address, Enveloper will present you with the main dialog box.    Check the
Zip Code text box to make sure the zip code is OK.    If you do not want to print the barcodes,
uncheck the "Print Bar Code" checkbox.

Choose the envelope template you want to use and click "Print", "Preview", or "Attach to 
Document".

For more detailed descriptions of the buttons in the main menu, choose one of the following:

Print
Preview
Attach To Document
Type New Address...
Zip Code
Envelope Note...
Setup
Number of Copies
Cancel



Printing Envelopes
Choose "Print" to send your envelope directly to your printer.    If you are using manual feed 
and you have your preferences set to "Beginner", you'll see a warning box to remind you to 
load your envelope and how you're supposed to load it.    After you become familiar with 
envelope printing, you can change your preferences to "Intermediate" to prevent this 
warning box.

During printing, you'll see some of the Windows Desktop show through your WinWord 
window.    Some people describe it as "the background is bleeding through".    This is normal.  
It is a consequence of the EchoOff routine Enveloper is using.    It does no harm.

Related Topics:

Print
Preview
Attach To Document
Type New Address...
Zip Code
Envelope Note...
Setup
Number of Copies
Cancel



Preview Envelope at Run Time
If you want to preview your envelope on screen, choose the "Preview" button.    You can 
make final modifications to your envelope before printing.    You can move the items on the 
envelope anywhere you like, change the fonts, etc.

Once you're in the Preview Mode, choose the envelope icon in the Toolbar or choose "Format
Envelope..." from the "Format" menu to get a Preview Mode Menu to help you with some 
common operations, including printing the envelope.

Choose "Exit Enveloper" from the Preview Mode Menu to quit.    Choose "Return to 
Enveloper" to rerun Enveloper on your letter.    Either way, you will lose all the changes you 
have made to the envelope, unless you have saved it manually for future use.

Related Topics:

Print
Attach To Document
Type New Address...
Zip Code
Envelope Note...
Setup
Number of Copies
Cancel



Attach to Document
Choose this button to attach the envelope to the end of your letter.    This is useful if you 
want to delay the printing of your letter, but would like to keep it and the letter in the same 
document.    Be sure that envelope is set for the correct feeder source, i.e. manual feed, 
enveloper tray, etc.

NOTE: This feature uses the clipboard to transfer the envelope to your document.    You will 
lose your clipboard contents.

Related Topics:

Print
Preview
Type New Address...
Zip Code
Envelope Note...
Setup
Number of Copies
Cancel



Changing Addressee
If the grabbed addressee is incorrect, Enveloper cannot grab an addressee, or you would 
like to change it in any way, you can use this dialog box to edit the addressee.

The OK button has been disabled in a way that hitting the "Enter" key will not blow this 
dialog box away.    The disadvantage is that you have to click on "OK" when your done, or 
TAB to it and press "Enter".

You can move around the different lines of the addressee by using TAB and SHIFT+TAB.    You
can also use the editing short cuts to Cut, Copy, and Paste.

Cut CTRL+X SHIFT+Delete
Copy CTRL+C CTRL+Insert
Paste CTRL+V SHIFT+Insert

Related Topics:

Print
Preview
Attach To Document
Zip Code
Envelope Note...
Setup
Number of Copies
Cancel



Zip Code 
Enveloper will attempt to get the zip code from the addressee.    It will fail, however, if the 
zip is not on the last line of the addressee.    In those cases, you'll have to either change the 
format of your addressee, or manually enter the zip each time.

Check to be sure that the zip code is correct and that the "Print bar code" box is checked to 
print the bar codes.    If you're using the special bar code fonts, be sure that they are 
installed correctly.    See Bar Code Fonts for more details.

Related Topics:

Print
Preview
Attach To Document
Type New Address...
Envelope Note...
Setup
Number of Copies
Cancel



Alternate Envelope Note
You can change the note you use for the envelope at run-time.    If you've designed your 
envelope template with a default note (the one that use the most, which could be blank), 
that note will be replaced by the new choice.    This provides maximum flexibility when you 
use envelope notes.

Related Topics:

Print
Preview
Attach To Document
Type New Address...
Zip Code
Setup
Number of Copies
Cancel



Changing Defaults
Choose the Setup button to invoke Customization for Enveloper.    From there, you can 
change Global Defaults, Edit Envelopes, Create Envelopes, etc.

Related Topics:

Print
Preview
Attach To Document
Type New Address...
Zip Code
Envelope Note...
Number of Copies
Cancel



Number of Copies
You can set the number of copies to print.    This sets the number of copies in WinWord, 
which is much slower than setting it in the "Printer Setup...".    Nevertheless, it is provided for
your convenience.

This is most useful if you want a set of preprinted envelopes.

Related Topics:

Print
Preview
Attach To Document
Type New Address...
Zip Code
Envelope Note...
Setup
Cancel



Cancel
Choose Cancel to exit Enveloper.    Pretty obvious, huh?

Related Topics:

Print
Preview
Attach To Document
Type New Address...
Zip Code
Envelope Note...
Setup
Number of Copies



Customizing Enveloper

You can start the customization by selecting "Enveloper4 Customize" from the "Tools" menu 
or "Setup..." when running Enveloper.    This is pretty obvious if you got here by clicking on 
the Help button.

Customization allows you to change some Global Defaults and to change and create custom 
envelopes.

The list box gives you the descriptions of the envelopes you have created.    To set the 
default envelope that Enveloper uses (the one it uses automatically), highlight the 
description from the list and click "OK"

To Edit, Create, or Delete an enveloper, choose the description, then click on one the the 
buttons:

Editing an Envelope Template
Creating a New Envelope Template
Deleting an Envelope Template



Editing an EnvelopeTemplate (main envelope Setup dialog box)
This is the granddaddy of all Enveloper's dialog boxes.    Almost everything happens here.    
You can customize your envelopes from here to your heart's content.    No changes become 
permanent until you click "OK".    If you don't already know, you get here by choosing 
"Enveloper4 Customize" from the "Tools" menu, then selecting an envelope from the list, 
then clicking "Edit...".    You also eventually get here if you chose "New...".

You can Preview your envelope from here and even do a TestPrint to make sure your 
envelope is feeding correctly and that all the items are lining up.

Click "OK" to save your changes and exit Editing mode, or click "Cancel" to discard all 
changes and exit.

For detailed explanations, choose one of the following:

Description... Source...
Size... Print Field...
Return... PrinterSpecificSettings...
Fonts... Preview...
Note... Test Print
Logo... OK
Cancel

See also

Creating a New Envelope Template
Deleting an Envelope Template



Changing the Envelope Description

Give your envelopes a descriptive name so you can pick it quickly from the list when you run
Enveloper.    Filenames are typically too short and cryptic to accurately describe your 
envelopes, so the description field is provided to ease the use of Enveloper.

The top dialog box in the main envelope Setup dialog box displayes the current Envelope 
Description.    If you would like to change it, click on "Description..." button.

Enter the Description in the dialog box.    Pressing "Enter" or clicking on "OK" will accept the 
new description for the current envelope.

Examples

Business, First Class
Business, Logo
Personal, ZapfChancery

See also

Envelope Editing Commands



Changing Envelope Size
The second dialog box in the main envelope Setup dialog box indicates the current envelope
size.    If you would like to change it, click on the "Size..." button.

The main box contains a list of predefined envelope sizes.    The description gives the 
common name for the envelope, as well as the actual dimensions.    Choose one of these for 
your envelope and click "OK".    If you would like it to be the default (so that new envelopes 
built from scratch will be set to this size automatically), choose "Save as Default" before 
clicking "OK".

If you do not find a size, choose "New..." to create a new one.    You can create a new 
envelope size.    See Entering an Envelope Size for more details.

If an entry is incorrect, or you would like to make modifications, choose "Edit...".    Also see 
Entering an Envelope Size for more details on how to enter a new size.

If there is an envelope size you do not use, choose "Delete..." to remove it from the list.

See also

Envelope Editing Commands



Entering an Envelope Size
You need to enter a description for an envelope size in addition to the actual dimensions.    
Be expressive in the description field, since this is what you will see from the list.    For added
clarity, include the dimensions in the description.

Click "OK" to accept the new values.

You will be asked if you want the new size to apply to the current envelope.    This is provided
so that you can enter several envelope sizes at the same time without actually changing the
current envelope size.

Example

Gift Envelope Large, 6.5" x 8.5"



Changing Return Address
The third box in the main envelope Setup dialog box shows the current return address in the 
envelope.    You associate a return address with an envelope, making it into a computer 
version of a preprinted envelope.    When you're ready to use Enveloper, just choose the 
envelope and go.    You don't have to continually change the return address at run-time.

If you have several return address that you commonly use (business and personal), just 
create a separate envelope for each return address.

Enveloper allows you to keep a list of return addresses for use in your envelopes.    If you 
have defined you address when setting up WinWord, you will have one listing already.    If the
current return address is not correct, click "Return Addr..." to get a list of the currently 
available return addresses.    Because the list does not display multi-lines, each separate line
of a return address is separated by a vertical bar.

Choose a return address from the list and click "OK" to insert it into your envelope.    If you 
would like that address to be the default, choose "Save as Default" before clicking "OK".    
The current default is listed in the bottom text box.    If you would like a blank return address,
choose "(none)" from the list.    Do not manually delete it from the envelope.

If you don't find one that you like, choose "New.." to enter a brand new address (it will start 
with the current default to save typing), or highlight an address from the list and click 
"Edit..." to change it.    Choose "Delete" to remove an unused return address.

See also

Entering Return Address
Using a Blank Return Address
Envelope Editing Commands



Entering Return Address
You can have a maximum of 6 lines for your return address.    Use the TAB and SHIFT+TAB 
keys to move between the lines.    The "Enter" key has been disabled so that you don't 
accidentally invoke "OK" when you press it.

When you're done, click on "OK" with the mouse or TAB to the "OK" button before pressing 
the "Enter" button.

You may use the editing keys to minimize typing.

Cut CTRL+X SHIFT+Delete
Copy CTRL+C CTRL+Insert
Paste CTRL+V SHIFT+Insert

Related Topics

Envelope Editing Commands
Using a Blank Return Address



Using a Blank Return Address
You do not need to enter a blank address.    Just choose "(none)" from the address list.

Also do not manually delete a return address from an envelope template.    This may confuse
Enveloper my misplacing the bookmarks.

Related Topics

Envelope Editing Commands
Entering Return Address



Changing Font Attributes
If you would like to change the default fonts in your envelope, click the "Fonts..." button from
the main envelope Setup dialog box.    You can change the character attributes of five items: 
First Line of Return Address, Other Lines of Return Address, First Line of Addressee, Other 
Lines of Addressee, Envelope Note.

The five buttons are just fast interfaces to the FormatStyleChar dialog box.    You can change 
anything you like, including the color!

When you're satisfied, click "OK" to return to the main envelope Setup dialog box.

NOTE: The Other Lines of Return Address has a style based on the First Line of Return 
Address, so if you want all lines of the return address to be the same, you need to change 
the attributes of only the first line.    The same applies to the Addressee.

WARNING: If you change the attributes of Other Lines of Return Address before changing 
First Line of Return Address, unexpected results may occur.    This is not a bug!    It's just the 
way WinWord handles styles.    If you are familiar with Styles, you'll have no problems.

See also

Envelope Editing Commands



Changing Envelope Note
The current envelope note is indicated in the "Envelope Note" box in the main envelope 
Setup dialog box.    If the box is blank, then the envelope has no notes.

You can enter a default note that you will use most of the time.    You can always change it at
run time.    Using a non-blank note may save you lots of time in the future.

To change the note, click on "Note..." from the main envelope Setup dialog box.

If you find a note in the list that you'd like to use, choose it and click "OK".    If you would like 
the note to apply to all newly created envelopes, choose "Save as Default" before clicking 
"OK".    Note that for multi-line notes, each line is separated by a vertical bar.    The current 
default is in the bottom text box.

If you do not find any note that you like, choose "New..." to enter a new one.    Use 
SHIFT+Enter to create multiline notes.    To change a note, choose "Edit...".    To remove an 
unused note, choose "Delete".    Removing unused notes may speed up Enveloper.

See also

Envelope Editing Commands



Inserting or Changing Logos
The "Logo File" text box in the main envelope Setup dialog box lists the filename of the logo 
in the current envelope.    If it is blank, there are no logos (that Enveloper knows about) in 
the envelope.    To add or change the logo, click on the "Logo..." button.

You can use any graphics for your logo that WinWord can import.    You might want to try 
importing and printing it with a regular document before trying it in Enveloper.

You'll be presented with three buttons, "Insert or Replace...", "Resize..", and "Delete".    

Choose "Insert or Replace..." to insert a new logo or replace the current one.    You'll be asked
by the InsertPicture dialog box for the graphic you want.    Use the list box at the bottom to 
limit your search ranges.    You'll be asked to size your logo.    If you like a scaled (non-
distorted) version of the original graphic, leave one of the dimension box blank.

Choose "Resize..." to change the size of the current logo.

Choose "Delete" to remove the logo from the current envelope.

NOTE: Any changes you make to logos will reposition the return address and/or the logo.    
You may need to use the Preview Mode to make sure that the placements are to your liking.   
If you don't like it, move it.    No problem.

See also

Insert or Replace...
Resize..
Delete
Envelope Editing Commands



Inserting or Replacing Logos
Choose "Insert or Replace..." to insert a new logo or replace the current one.    You'll be asked
by the InsertPicture dialog box for the graphic you want.    Use the list box at the bottom to 
limit your search ranges.

If you like a scaled (non-distorted) version of the original graphic, leave one of the dimension
box blank.

NOTE: Any changes you make to logos will reposition the return address and/or the logo.    
You may need to use the Preview Mode to make sure that the placements are to your liking.   
If you don't like it, move it.    No problem.

See also

Logos in Envelopes
Envelope Editing Commands



Resizing Logos
You can resize your logo to any size.    Just enter the width and height dimensions.    If you 
want to scale the logo equally in each dimension, leave one dimension blank.

To reset the logo back to its original size, click "Reset Size".

NOTE: Any changes you make to logos will reposition the return address and/or the logo.    
You may need to use the Preview Mode to make sure that the placements are to your liking.   
If you don't like it, move it.    No problem.

See also

Logos in Envelopes
Envelope Editing Commands



Deleting Logos
Use this interface to delete a logo inserted by Enveloper to ensure proper cleanup.    Do not 
try to manually remove the logo in Preview Mode.

NOTE: Any changes you make to logos will reposition the return address and/or the logo.    
You may need to use the Preview Mode to make sure that the placements are to your liking.   
If you don't like it, move it.    No problem.

See also

Logos in Envelopes
Envelope Editing Commands



Change Envelope Source
You can choose to have your envelopes feed from a different source than your paper.    
Choose the "Source..." button from the main envelope Setup dialog box to change the 
source.    The current one is listed in the text box.

Enveloper feeder users will want to choose Envelope from the list AND make sure that they 
check the "Printer's Envelope Feeder has been Installed" from the Tools, Options, Print dialog
box.    (Choose the "Tools" menu, click on "Options", click on "Print").

NOTE: If you do not want to go to your printer to put it on-line every time you print an 
envelope, leave the source on "Default".    Do not choose "Manual Feed".    All you have to do 
is stick an envelope into the manual feed before running Enveloper (at least before clicking 
"Print"), and the envelope will get pulled in automatically.

See also

Envelope Editing Commands



Using Print Fields
Print Fields are an advanced, but important, part of Enveloper.    It allows us to control the 
printer in ways that WinWord can't.    In particular, we can make certain printers print in 
Reverse Landscape mode to minimize smudging by having the return address print first.    
You can send any printer commands to your printer in this fashion to control almost any 
function of the printer directly, including turning on and off Duplex printing.

To date two types of printers allow Reverse Landscape printing: PCL5 printers (LaserJet III 
series) and PostScript printers.    If you have one of these printers and would like to use 
Reverse Landscape printing (and if you did not install it with this option), choose "Print 
Fields..." from the main envelope Setup dialog box.

Choose the appropriate description and click "OK".    If you would like it to apply to all newly 
created envelopes, check "Save as Default" before clicking "OK".

NOTE: PostScript printer users using Windows 3.0 do not need Print Fields for Reverse 
Landscape printing.

PostScript printer users using Windows 3.1 need to choose the correct Reverse Landscape 
codes for the page size.    If you don't find one that suits your needs, you can create a new 
one.

Choose "New..." to create a new Print Field, "Edit..." to change an existing Print Field 
Description or Print Field Code, or "Delete" to remove an unused Print Field.

See also

Print Field Description
Print Field Code
Envelope Editing Commands



Print Field Description
Why Descriptions?

Since Print Field Codes are just printer commands, they don't often make very much sense 
just at a glance, that's why we associate a Description for each Print Field Code.    So be 
descriptive.

After entering the description, you'll get two warning boxes reminding you how Print Field 
Codes should be entered before you actually enter the Print Field Codes.

Example

PCL Duplex OFF
PostScript ReverseLandscape for Com10

See also

Using Print Fields
Envelope Editing Commands



Printer Field Codes
Remember that the Print Field Description should be descriptive of the code you're about to 
enter.    Needless to say, you need to be careful with Print Fields.    You may need to test them
out with a regular document before recording it with Enveloper.

PCL Example
Because it's hard to enter the Esc character,Chr$(27), Enveloper allows you to enter it 
using the 4 characters "ESC ".    (Note the trailing space).    This sequence is commonly used 
in PCL printers as well as dot-matrix printers.

The dialog box you'll be presented has the minimum code that you need:

print " "

The code actually goes in between the double quotes, e.g.,

print "ESC &a180P ESC &l1E "

This is the code for "PCL5 Reverse Landscape (LJIII's)".    The trailing blank space is 
important.

PostScript Example
PostScript commands are also entered directly.    The most important PostScript commands 
are for Reverse Landscape.    It needs to be customized for each paper size you use.    Two 
standard ones are provided for letter-sized paper and for Com10 sized paper.    If you need to
modify the code, the following is the guideline:

print "11 .52 sub 300 mul 8.5 .5 sub 300 mul translate 180 rotate "

The number marked in red are the ones that you may need to change:

Page Height (long dimension): 11 in
Page Width (short dimension): 8.5 in
Printer Resolution (dpi): 300

European users can modify the following:

print "29.7 2.54 div .52 sub 300 mul 21 2.54 div .5 sub 300 mul translate 180 rotate "

The changeable values are:

Page Height (long dimension): 29.7 cm
Page Width (short dimension): 21 cm
Printer Resolution (dpi): 300

See also

Using Print Fields
Envelope Editing Commands



Printer Specific Settings
Printer Specific Settings allow you to fine tune the envelope individually to fit a particular 
printer.    These settings may be made global so that all newly created envelopes will share 
the same characteristics.    This can be accessed by clicking on the "Printer Specific 
Settings..." button in the main envelope Setup dialog box.

The available commands are:

Barcode Positioning
Minimum Margins
Feeder Characteristics
Fit Page To Envelope

See also

Envelope Editing Commands



Nudging Bacode Position

Where should it be?
The POSTNET bar code have a fairly well defined position on the envelope.    Enveloper 
attempts place it with respect to the edges of your envelope, but depending on your printer, 
it might be off slightly.    The requirements are as follows:

Horizontal Placement:    Measure the distance from the leftmost printed bar code to
the right edge of the envelope.    This distance should be between 3.25 and 4.0 
inches.

Vertical Placement:    The distance from the top of the printed bar code to the 
bottom of the envelope should be 1/4 inch plus or minus 1/16 of an inch.    

How do I change it?
Choose the Printer Specific Settings button from the main envelope Setup dialog box.    Then 
click on the "Bar Code Position" button.    Change the values in the edit boxes and press 
"OK".

Default positions for Postal Bar Code:
Horizontal Placement: 288pt or 4 inches from the first bar to the right edge of the 
envelope.
Vertical Placement: 26pt or approximately .5" from the top of the first bar to the 
bottom edge of the envelope.

The units are in points with 72pts = 1 inch and 28.35pts = 1 cm.      

If you want to reset the position to "factory defaults", click "Reset".

Is the bottom of your bar codes being cut off?
If yes, you've either run into physical limitations of your printer (sorry), or you need to 
change your Minimum Margins (see Related Topics).

Related Topics

Minimum Margins
Feeder Characteristics
Fit Page To Envelope

See also

Envelope Editing Commands



Setting Enveloper Page Margins

Why do I need to change this?
1. Most printers cannot print to the edges of a page.    There are usually minimum 

margins required by each printer driver.    If you find that your printer driver is giving 
you warning messages, you might want to change the minimum margins settings 
until the messages go away.

2. You might want to change the top margin value to get your return address printed 
closer to the envelope edge; this is especially true for portrait mode printers.

3. You may need to change the bottom margin to prevent your bar codes from getting 
cut off.

How do I change it?
To find the proper settings for your printer, use the Preview Mode to view your envelope.    
Manually change the margins with Format Page Setup and print the envelope.    Repeat until 
the error message disappear.    The most likely culprits are the Top and Right margins, so 
change those values first.    Make a note of the settings, because we need to record it with 
Enveloper.

Choose the Printer Specific Settings button from the main envelope Setup dialog box.    Then 
click on the "Minimum Margins" button.    Change the values in the edit boxes and press 
"OK".

Related Topics

Barcode Positioning
Feeder Characteristics
Fit Page To Envelope

See also

Envelope Editing Commands



Envelope Feed Characteristics

What does this do?
This is how Enveloper supports multiple printer types.    Since different printers feed 
envelopes differently, you can tailor each envelope for a specific printer.

How Do I do it?
Choose the Printer Specific Settings button from the main envelope Setup dialog box.    Then 
click on the "Feeder Characteristics" button.    Make your selections in the four Option boxes 
and press "OK".

The dialog box is identical to the initial installation question asking you to choose printer 
characteristics.    This also means that if you've installed with the incorrect setting, you can 
change it here.

The parenthesis help guide you in your choices by listing the common printers.    You do not 
have to follow them.    Mix and match to suit your printer's needs.    See Printer Selection for 
some hints.

Related Topics

Barcode Positioning
Minimum Margins
Fit Page To Envelope

See also

Envelope Editing Commands



Fitting Page to Envelope

Why do I need it?
Some printer drivers, especially those for enveloper feeders do not like being sent a 
document that is letter-sized.    In those cases, you need to fit the page to the envelope.    If 
you use a PostScript printer, are using Windows 3.1, and are using Reverse Landscape 
printing, you need to update your Print Field Codes to reflect the change in page size.

Why don't you always use this?
Enveloper uses a letter-sized paper to create envelopes to provide a consistent envelope 
location in your feeder for all your envelopes, no matter what size you're using and which 
printer you're using.    Otherwise, you'll be continually fiddling print "Printer Heuristic" 
settings in your WIN.INI file in order for you envelopes to print out correctly.

Using the exact size on some PostScript printers, for example, a COM10 envelope requires 
center-feed, but an odd-sized envelope jumpt to flush right!    How is the user supposed to 
know where his envelopes will come out?    That's why Enveloper uses a full letter-sized 
page to define the envelope location.

How do I change this?
This setting is a toggle.    That is, it just changes from "Fit Page to Envelope" to "Use Letter-
sized Page" and vise versa.

Choose the Printer Specific Settings button from the main envelope Setup dialog box.    If 
you're using a letter-size paper, click on the "Fit Page to Envelope" button.    If you're already 
using Fit Page to Envelope, the button will read "Use Letter-sized Page".    Click it to change.

Related Topics

Barcode Positioning
Minimum Margins
Feeder Characteristics

See also

Envelope Editing Commands



Previewing the Envelope
You can get a mental picture of what your envelope will look like on screen, without printing, 
by using the Preview Mode.

It also enhances your envelope editing capability by allowing to move the envelope objects 
(logo, addresses, note) anywhere you like on the envelope.    Just move the cursor to the 
edge of one of the frames until it turns into a four-headed arrow.    Now drag and move the 
frame.

To enter preview mode, click on the "Preview" button in the main envelope Setup dialog box.

For more details, see Using Preview Mode.

See also

Envelope Editing Commands



Making a Test Print
To get a test print of your envelope when you're designing it, click "Test Print" from the main 
envelope Setup dialog box.

The test printing will be identical to the final envelope except for the Addressee.    It will also 
use the Envelope Source that you have chosen, just to make sure all the pieces are fitting 
together.

See also

Envelope Editing Commands



Saving Envelope Changes
Choose "OK" from the main envelope Setup dialog box to record all changes and return to 
the main Customize dialog box with the list of envelopes.

Highlight the envelope you want to be the default and click "OK", or simply click "Cancel" if 
you do not want to change the default.

You can also edit or create another envelope.    Enjoy!

See also

Envelope Editing Commands



Discarding Envelope Changes
If you do not want to keep the changes that you've made to the envelope, click "Cancel" 
from the main envelope Setup dialog box.    This will close your envelope template without 
saving and return you to the main Customize dialog box with the list of envelopes.

Highlight the envelope you want to be the default and click "OK", or simply click "Cancel" if 
you do not want to change the default.

You can also edit or create another envelope.    Enjoy!

See also

Envelope Editing Commands



Creating a New Envelope
If you don't already know, you get here by choosing "Enveloper4 Customize" from the "Tools"
menu, then selecting an envelope from the list, then clicking "New...".

If you selected "(none)" from the list before clicking "New...", you will be creating a brand 
new envelope with your current defaults.    If you selected another envelope before clicking 
"New...", you will start with an identical copy of that envelope.    This makes it easy to make 
several envelopes that differ only slightly, such as for different return addresses or different 
sizes.

Whichever you choose, you will be prompted to enter a file name for your new envelope 
template (Envelope Template Filename).    The list makes it easy for you to tell what is there 
already.    Don't forget to also enter a new Description at the bottom!    You will choose your 
envelopes at run-time using these Descriptions.

If you chose "(none)" before clicking "New...", you will be prompted next for the Envelope 
Size.    Choose one from the list and click "OK".

Finally, you will enter the main envelope Setup dialog box for additional changes you'd like 
to make to your envelope.

See either of the following for step-by-step instructions on creating an envelope:

Creating an Envelope from Scratch
Creating an Envelope base on Existing Envelope

See also

Editing an Envelope Template
Deleting an Envelope Template



Envelope Template Filename
You can give your envelope template any legal DOS filename, but we recommend the .ENV 
extension.    If you give a name without an extension, Enveloper will tack on the .ENV.

The list box shows all the .ENV files in the directory to help you choose a unique name.

Since DOS limit you to only 8 characters for filenames, they cannot be very descriptive.    
Thus Enveloper uses real text strings for Descriptions of your envelopes.    So don't forget to
enter or change your description at the bottom of the dialog box!

Example:
Com10.env
Cm10logo

See also

Envelope Description



Envelope Description
The Envelope Description is what you see when you run Enveloper.    You enter any 
description you want for the envelopes you create.    Be descriptive!    It will save you time.

If you forget to enter a new description, don't panic.    You can always edit it later (see 
Changing the Envelope Description).

Example:
Business, TimesRoman
Business, Logo, Home Addr
Personal, ZapfChancery
Gift Card, Linotext

See also

Envelope Template Filename



Envelope Size
If you selected "(none)" before clicking on "New..." to create a brand new envelope, you will 
be asked which envelope size to use.    Choose one from the list, click "OK", and sit back for a
minute while Enveloper creates your new envelope.

If you do not find a size to your liking, you can create a new one to add to the list.    See 
Changing Envelope Size for more details.

See also

Changing Envelope Size



Editing a New Envelope
If you created an envelope from scratch, Enveloper will use the current defaults you've set 
for the return address, envelope note, print fields, feed characteristics, etc. for the new 
envelope.    If you chose to base it on an existing envelope, you will start with an identical 
copy of the base envelope.

Either way, you'll end up in the main envelope Setup dialog box, where you can make any 
changes you like for your new envelope.

See also

Editing an Envelope Template



Creating a Brand New Envelope
Following are the steps-by-step instructions to creating a new business sized envelope with 
the description "Standard Business".    This template is created from "scratch" meaning it is 
not based on another envelope template.

1. Run the Enveloper Customization macro by choosing "Enveloper4 Customize" 
from the Tools menu.

2. Choose "(none)" from the Envelope Description list and choose the New... button.
3. You will prompted for a filename for the new template.    For this example, type 

"BUSINESS.ENV" under the "New Envelope Filename" text.    In the Envelope 
Description box at the bottom of the dialog box, type "Standard Business" and 
choose the OK button.

4. You will then be prompted to choose an envelope size.    For this example, choose 
"Business Com 10 - 4.125 in x 9.5 in" (European/Metric users should choose 
"Business DL - 11.0 cm x 22.0 cm".)    Choose the OK button.
Note:    In the background you will see documents being opened and manipulated as 
Enveloper begins to build the envelope template file.
Enveloper will then bring you to the main customization dialog box.    The command 
buttons in this dialog are used to customize the envelope template.    The top box 
displays the Envelope Description that you entered previously.    The Envelope Size 
box displays the selected size for envelope (selected in step 4 above).    If you have a 
default return address or envelope note, they will display in this dialog.

5. If your return address does not appear or is not accurate, choose the Return 
Addr... button to change the return address information.    Choose the New button to 
create a new return address or select a address and choose the Edit button to edit 
the current return address information.    Once you have edited or added a new 
address, choose the OK button.    You will then be asked if you want to use the new 
return address for this envelope.    Choose Yes to this prompt and the return address 
will update to reflect your changes.

6. If you would like to change the Envelope Note, choose    the Note... button.    
Select a note from the list of envelope notes and choose OK.    If none of the envelope
notes are appropriate for your envelope, choose the New button to add a new note or
choose the Edit button to change the text of the selected envelope note.

7. Choose the Fonts... button to change the font selections for the envelope 
text.    There are five envelope items that you can choose to configure: Return 
Address Line 1, Return Address Others, Addressee Line 1, Addressee Others, or 
Envelope Note.    When you select one of these five buttons, you will be presented 
with the Format Character dialog box for the selected styles.
Note:    "Return Address Others" is based on "Return Address Line 1".    As a result, 
changing the character formatting for "Return Address Line 1" will also change the 
formatting for "Return Address Others".    The same is true for "Addressee Line 1" and 
"Addressee Others".

8. The Envelope Source near the bottom of the dialog lists the currently 
selected envelope feed source.    If this selection is not correct, choose the Source...
button.    In the resulting dialog select the appropriate envelope feed source and 
choose the OK button.

9. Finally, choose the OK button from the main customize dialog.    This will save all the
changes that you have made to your envelope template file.    Select the new 



envelope description and choose OK to set the new template as the default envelope 
template.

See also

New Envelope Based on Existing One



New Envelope Based on Existing One
Once you have created one envelope template it is easy to create new ones.    When 
creating a new template you can choose to base the new template on an existing envelope 
template.

For example, if you've already created a business envelope for domestic mail and want 
another template for foreign mail that includes the note, "Air Mail", you can base the new 
template on the existing one and just change the Envelope Note.

Or if you need to print to monarch sized envelopes, you can base the monarch envelope 
template on the Com-10 Business envelope and then change the size. 

To base a new template on an existing template, do the following:

1. Choose Enveloper4 Customize from the Tools menu.
2. Select the template to base the new template on (such as Sample Envelope) from 

the list of Envelope Descriptions.
3. Choose the New button.
4. In the following dialog there is a list of existing template files ending with the ENV file

extension.    Below the text "New Envelope Filename" is a proposed filename for your 
new template (i.e. TEMP12.ENV).    Edit this filename if you would like a filename 
other than the proposed (leave the ENV file extension).    If you do not enter a file 
extension, .ENV will be appended.

5. Enter an Envelope Description for your new template in the box toward the bottom
of the dialog.

6. Choose the OK button and Enveloper will build a new template with the same 
settings as the original template.

Once the new template is created, Enveloper will bring you to the main customization 
dialog box.

The command buttons in this dialog are used to customize the envelope template.    The top 
box displays the Envelope Description that you entered previously.    The Envelope Size box 
displays the selected size for envelope (size of the original envelope).    If you have a default 
return address or envelope note, they will display in this dialog.

To perform any changes, follow the procedure described in Step 5 in the following section, 
Creating an Envelope Template From Scratch.

See also

Creating a Brand New Envelope



Deleting an Envelope
If you don't already know, you get here by choosing "Enveloper4 Customize" from the "Tools"
menu

Simply choose the Envelope Template you wish to remove and click on "Delete".    
Enveloper will remove the description from the list and delete the file from disk.

See also

Editing an Envelope Template
Creating a New Envelope Template



Setting Global Defaults
If you don't already know, you get here by choosing "Enveloper4 Customize" from the "Tools"
menu, then choose the Set Global Defaults... button to indicate the following items:

Preference level (Beginner, Intermediate, Expert)
Addressee Grab Method (Microsoft's Grab, SmartGrab ,SkipLines)
Print Zip Bar Code
Use MSLineDraw for Bar Codes



Enveloper Preference Levels
If you don't already know, you get here by choosing "Enveloper4 Customize" from the "Tools"
menu, then choose the Set Global Defaults... button.

Choose from three different preference levels depending upon your familiarity with 
Enveloper.

Beginner is the default setting for Enveloper.    With this setting there will be 
warning messages when printing manual feed envelopes and when entering the 
Preview mode.

If you grow tired of these messages after using Enveloper for some time, change the
preference level from "Beginner" to "Intermediate".

Choosing the "Expert" mode will eliminate all dialog boxes.    If the Expert mode is 
employed and you click the envelope button, the envelopes will be printed without 
any intervention on your part.    In "Expert" mode, Enveloper will use the default 
template and the default grabbed addressee to print the envelope without any 
prompts at all.    Of course, you'll have to set up your default envelope template as 
you would like.

An alternative to the "Expert" mode, would be to create a new macro called something like 
"QwikEnveloper".    This macro would contain a command similar to the following:

Sub Main
Enveloper4.Enveloper(1, "c:\winword\env\com10.env")

End Sub

The above macro will run Enveloper without prompts and will use the envelope template 
named "C:\WINWORD\ENV\COM10.ENV"; the full pathname for your envelope template 
should be used.    The above macro will allow you to have both the interactive Enveloper 
and a fully-automated Enveloper under the name QwikEnveloper.    This method also 
allows you to change the default Enveloper template without affecting the envelope 
template used by "QwikEnveloper".

See also

Addressee Grab Method
Print Zip Bar Code
Use MSLineDraw for Bar Codes



Addressee Grab Methods
If you don't already know, you get here by choosing "Enveloper4 Customize" from the "Tools"
menu, then choose the Set Global Defaults... button.

Enveloper provides three different options available for "grabbing" the addressee 
information from a Word for Windows document:

Microsoft's addressee grab
SmartGrab
SkipLines

Each method has its advantages and disadvantages.    After reading through the following 
explanation of the three grab options you can decide which will work best for you.

After grabbing an addressee, Enveloper presents the addressee information for your 
approval.    You can either accept the grabbed addressee or type in an entirely new 
addressee on-the-fly.

Enveloper scans the end of the addressee information for a 5 or 9 digit zip code.    If a zip 
code is found, the zip code is presented for you to accept or modify.    The zip is used to print 
a bar code conforming to the U.S Postal Service's POSTNET standards.    If your zip code is 
not the last item in your addressee, Enveloper will not be able to find it automatically.

Note:    If all three methods (Microsoft's addressee grab, SmartGrab, or SkipLines) fail to grab
an address, you'll be prompted to manually type in an address for the addressee.

See also

Preference level
Print Zip Bar Code
Use MSLineDraw for Bar Codes



Microsoft's Grab
This is the grab routine used by the Word for Windows internal envelope feature.    This 
method is the fastest of the three, but not always accurate.    "Microsoft's addressee grab" is 
the default setting for Enveloper.    The algorithm works as follows:

1. If you have text highlighted, it will be used as the addressee.
2. If you have a bookmark called "EnvelopeAddress", the contents of that bookmark will 

be used for the addressee.
3. If you have left justified text that is 3 to 5 lines long, none over 58 characters, it will 

be used as the addressee. Tabs within the address are not allowed (everything after 
the Tab is truncated).

See also

SmartGrab
SkipLines
Addressee Grab Method



Smart Grab
SmartGrab is very similar to the Word for Windows grab routine, but is slower since it uses 
WordBasic commands to search for the addressee.    This method for grabbing addressee 
information does, however, result in fewer incorrect "grabs".    If you find that "Microsoft's 
addressee grab" is not working for you try the SmartGrab option.    The algorithm used by 
SmartGrab is as follows:

1. If you've selected a block of text Enveloper grabs the selected text and uses it as 
the addressee (the selection must be > 10 characters long, and long addresses will 
be truncated to 215 characters and seven lines).

2. If you have a defined bookmark called "NameAddress" (which is a common name in 
the Word for Windows templates), Enveloper will grab the bookmark text as the 
addressee (again, truncated at 215 characters and seven lines).

3. If you have a defined bookmark called "EnvelopeAddress"(which is the name used by 
Microsoft's ToolsCreateEnvelope), Enveloper will grab everything in that bookmark 
as the addressee.

4. And finally as a last resort, the text meeting the following criteria will be grabbed:
i) Left-justified
ii) Three or more non-blank text lines that do not include a picture nor are part of

a Word for Windows table.

See also

Microsoft's addressee grab
SkipLines
Addressee Grab Method



Skip Lines
SkipLines is the most rigid of the three methods.    The idea here is that you indicate how 
many lines you want Enveloper to skip (from the beginning of file) before Enveloper starts 
to look for non-blank text to be used as the addressee.    SkipLines is used only if steps 1 
through 3 fail:

1. If you've selected a block of text Enveloper grabs the selected text and uses it as 
the addressee (the selection must be > 10 characters long, and long addresses will 
be truncated to 215 characters and seven lines).

2. If you have a defined bookmark called "NameAddress" (which is a common name in 
the Word for Windows templates), Enveloper will grab the bookmark text as the 
addressee (again, truncated at 215 characters and seven lines).

3. If you have a defined bookmark called "EnvelopeAddress"(which is the name used by 
Microsoft's ToolsCreateEnvelope), Enveloper will grab everything in that bookmark 
as the addressee.

4. Skip the specified number of lines and grab the next block of non-blank text to use as
the addressee.

See also

Microsoft's addressee grab
SmartGrab
Addressee Grab Method



Enabling POSTNET Bar Codes
If you don't already know, you get here by choosing "Enveloper4 Customize" from the "Tools"
menu, then choose the Set Global Defaults... button.

With Enveloper, you have the option of printing bar codes (called "POSTNET" codes) where 
the United States Postal Service would like them printed on envelopes.    This global setting 
called "Print Zip Bar Code" is enabled by default.    To change this setting, do the following:

The check box before the text "Print Zip Bar Code", indicates whether the option is enabled.  
Click within the check box to mark or unmark the box or press ALT+Z from the keyboard.

NOTE: Enveloper will automatically grab your zip code from the addressee, but only if the 
zip is the last item on the line.

See also

Preference level
Addressee Grab Method
Use MSLineDraw for Bar Codes
Bar Code Position



Using MSLineDraw for Bar Codes
If you don't already know, you get here by choosing "Enveloper4 Customize" from the "Tools"
menu, then choose the Set Global Defaults... button.

If you wish to use the MSLineDraw font to generate POSTNET bar codes, regardless of 
whether you've installed special fonts (TrueType or ATM), check the box marked "Use 
MSLineDraw".

Remember to UNCheck the box to use your special fonts.

NOTE: DO NOT use MSLineDraw for PostScript printers.    It will print very slowly.

WARNING: MSLineDraw is the slowest method for creating bar codes.    If you do have access
to TrueType or ATM, use those alternatives instead.

See also

Preference level
Addressee Grab Method
Print Zip Bar Code



Changing Font Properties
Enveloper uses paragraph styles for the various text items on the envelope.    Although you 
can use the standard WinWord methods to change the font properties of the styles while in 
Preview Mode, Enveloper provides easy access via special dialog boxes you can access 
from either the main envelope Setup dialog box, or the Preview Menu in the Preview mode.

The item for which you can change character properties you are:

First Line of Return Address
Others Line of Return Address
First Line of Addressee
Others Line of Addressee
Envelope Note



Font for First Line of Return Address
The Paragraph Style for the first line of the return address is "EnvRetAddr".    To easily 
change the font characteristics, choosing "Fonts..." from the main envelope Setup dialog 
box.    Choose "Return Addr Line 1" and you will be presented with the standard 
FormatDefineStyleChar dialog box.    Change anything you like.    You'll see a font preview in 
the bottom right corner.

Note that the style for the rest of the return address, "EnvRetAddrRest", is based on this 
style.    If you want all line to be the same, you need only change the "EnvRetAddr" style.

NOTE: If you've changed the "EnvRetAddrRest" style already, changing the "EnvRetAddr"
style may result in unexpected results.

NOTE: You do not need to choose the "Use As Default..." button.    Just click "OK".

See also

Others Line of Return Address
First Line of Addressee
Others Line of Addressee
Envelope Note
Envelope Fonts



Font for Other Lines of Return Address
The Paragraph Style for the rest of the lines of the return address is "EnvRetAddrRest".    To
easily change the font characteristics, choosing "Fonts..." from the main envelope Setup 
dialog box.    Choose "Return Addr Rest" and you will be presented with the standard 
FormatDefineStyleChar dialog box.    Change anything you like.    You'll see a font preview in 
the bottom right corner.

Note that the style for the rest of the return address, "EnvRetAddrRest", is based on this 
style.    If you want all line to be the same, you need only change the "EnvRetAddr" style.

NOTE: If you've changed the "EnvRetAddrRest" style already, changing the "EnvRetAddr"
style may result in unexpected results.

NOTE: You do not need to choose the "Use As Default..." button.    Just click "OK".

See also

First Line of Return Address
First Line of Addressee
Others Line of Addressee
Envelope Note
Envelope Fonts



Font for First Line of Addressee
The Paragraph Style for the first line of the addressee is "EnvAddressee".    To easily change
the font characteristics, choosing "Fonts..." from the main envelope Setup dialog box.    
Choose "Addressee Line 1" and you will be presented with the standard 
FormatDefineStyleChar dialog box.    Change anything you like.    You'll see a font preview in 
the bottom right corner.

Note that the style for the rest of the return address, "EnvAddresseeRest", is based on this
style.    If you want all line to be the same, you need only change the "EnvAddressee" style.

NOTE: If you've changed the "EnvAddresseeRest" style already, changing the 
"EnvAddressee" style may result in unexpected results.

NOTE: You do not need to choose the "Use As Default..." button.    Just click "OK".

See also

First Line of Return Address
Others Line of Return Address
Others Line of Addressee
Envelope Note
Envelope Fonts



Font for Other Lines of Addressee
The Paragraph Style for the rest of the lines of the addressee is "EnvAddresseeRest".    To 
easily change the font characteristics, choosing "Fonts..." from the main envelope Setup 
dialog box.    Choose "Addressee Rest" and you will be presented with the standard 
FormatDefineStyleChar dialog box.    Change anything you like.    You'll see a font preview in 
the bottom right corner.

Note that the style for the rest of the return address, "EnvAddresseeRest", is based on this
style.    If you want all line to be the same, you need only change the "EnvAddressee" style.

NOTE: If you've changed the "EnvAddresseeRest" style already, changing the 
"EnvAddressee" style may result in unexpected results.

NOTE: You do not need to choose the "Use As Default..." button.    Just click "OK".

See also

First Line of Return Address
Others Line of Return Address
First Line of Addressee
Envelope Note
Envelope Fonts



Font for Envelope Note
The Paragraph Style for the envelope note is "EnvNote".    To easily change the font 
characteristics, choosing "Fonts..." from the main envelope Setup dialog box.    Choose 
"Envelope Note" and you will be presented with the standard FormatDefineStyleChar dialog 
box.    Change anything you like.    You'll see a font preview in the bottom right corner.

NOTE: You do not need to choose the "Use As Default..." button.    Just click "OK".

See also

First Line of Return Address
Others Line of Return Address
First Line of Addressee
Others Line of Addressee
Envelope Fonts



Using Preview Mode

What is it?
The Preview mode allows you to view your envelope in the Page Layout view of Word for 
Windows.    This not only allows you to visualize your envelope, but also reminds you how 
your envelope feeds into the printer in relation to your regular letter sized (or A4 sized) 
paper.

Envelope borders are drawn to help you better visualize your envelope.    In the Preview 
mode, you view the layout of your envelope and reposition envelope items as necessary.    
You can move the envelope items anywhere you want on the envelope, and format the text 
items as you would like.      There are really only two rules to remember when working in the 
Preview mode of Enveloper4:

1. Never manually delete any item from the previewed envelope.    If you wish to delete 
an item such as a return address or logo, do so from the Main Customize dialog.    
Deleting items from the Preview mode may cause unpredictable results when 
Enveloper is working with your Envelope template.

2. Use the "  Enveloper   dialog interface"   when formatting changes other than 
repositioning frames on the envelope.    The "Enveloper dialog interface" can be 
accessed by selecting Envelope Defaults from the Format menu, or double click on 
the button labeled "Double-Click for Menu" in the lower left corner of the envelope.

Both of the above "rules" will not be broken if you follow the steps outlined under the 
heading "Repositioning Items in Preview Mode" and    "Formatting in   Enveloper  's Preview   
Mode".

How do I get there?
You enter the Preview Mode of Enveloper from the Enveloper4 and Enveloper4 
Customize macros.

While customizing an envelope template from the Main Customize dialog, click on the
Preview button or...

Run Enveloper itself (at "run-time") by choosing the Envelope button from the 
Toolbar and clicking on the Preview button.

The mechanics are the same for either method, but there are subtle differences.    The 
primary difference being that changes made at run-time are not saved to the envelope 
template unless you explicitly save them with the File Save command.    In contrast, if you 
make changes in the Preview mode when accessed from the Main Customize dialog, the 
changes are saved automatically.    

Special Preview Menu
A special   Enveloper   interface   is provided while you're in Preview Mode.    You can access 
this by either clicking on the Envelope button on the Word for Windows Toolbar, or by 
selecting Envelope Defaults from the Format menu.

The resulting dialog provides easy access to the Character Formatting dialog boxes for the 
lines of envelope text, as well as options to print the envelope, exit preview, and resize the 
graphic logo.



See also

Repositioning Items in Preview Mode
Exiting Preview



Accessing Preview Menu
A special Enveloper interface is provided while you're in Preview Mode.    You can access 
this by either clicking on the Envelope button on the Word for Windows Toolbar, or by 
selecting Envelope Defaults from the Format menu.

The resulting dialog provides easy access to the Character Formatting dialog boxes for the 
lines of envelope text, as well as options to print the envelope, exit preview, and resize the 
graphic logo.

To find out more about these, choose one of the following:

Return Addr Line 1
Return Addr Rest
Addressee Line 1
Addressee Rest
Envelope Note
Resize Logo
Print Envelope
Preview
OK    ( or Exit Enveloper)
Cancel    ( or Return to Enveloper)

Note:    When accessed from the Enveloper4 macro instead of the Enveloper4 Customize 
macro, the last two buttons will be different.    The last two buttons will read "Exit 
Enveloper" and "Back to Enveloper".      The Exit Enveloper button will exit Enveloper 
entirely, bringing you back to your document window.    The Back to Enveloper button will 
bring you to the Main Customize dialog of Enveloper.    Again, changes made in Preview 
when accessed from Enveloper4 will not be saved to the envelope template unless you 
explicitly save them with the File Save command.    



Preview Font for First Line of Return Address
The Paragraph Style for the first line of the return address is "EnvRetAddr".    Choose 
"Return Addr Line 1" from the Preview Menu and you will be presented with the standard 
FormatDefineStyleChar dialog box.    Change anything you like.    You'll see a font preview in 
the bottom right corner.

Note that the style for the rest of the return address, "EnvRetAddrRest", is based on this 
style.    If you want all line to be the same, you need only change the "EnvRetAddr" style.

NOTE: If you've changed the "EnvRetAddrRest" style already, changing the "EnvRetAddr"
style may result in unexpected results.

NOTE: You do not need to choose the "Use As Default..." button.    Just click "OK".

See also

Preview Menu



Preview Font for Other Lines of Return Address
The Paragraph Style for the rest of the lines of the return address is "EnvRetAddrRest".    
Choose "Return Addr Rest" from the Preview Menu and you will be presented with the 
standard FormatDefineStyleChar dialog box.    Change anything you like.    You'll see a font 
preview in the bottom right corner.

Note that the style for the rest of the return address, "EnvRetAddrRest", is based on this 
style.    If you want all line to be the same, you need only change the "EnvRetAddr" style.

NOTE: If you've changed the "EnvRetAddrRest" style already, changing the "EnvRetAddr"
style may result in unexpected results.

NOTE: You do not need to choose the "Use As Default..." button.    Just click "OK".

See also

Preview Menu



Preview Font for First Line of Addressee
The Paragraph Style for the first line of the addressee is "EnvAddressee".    Choose 
"Addressee Line 1" from the Preview Menu and you will be presented with the standard 
FormatDefineStyleChar dialog box.    Change anything you like.    You'll see a font preview in 
the bottom right corner.

Note that the style for the rest of the return address, "EnvAddresseeRest", is based on this
style.    If you want all line to be the same, you need only change the "EnvAddressee" style.

NOTE: If you've changed the "EnvAddresseeRest" style already, changing the 
"EnvAddressee" style may result in unexpected results.

NOTE: You do not need to choose the "Use As Default..." button.    Just click "OK".

See also

Preview Menu



Preview Font for Other Lines of Addressee
The Paragraph Style for the rest of the lines of the addressee is "EnvAddresseeRest".    
Choose "Addressee Rest" from the Preview Menu and you will be presented with the 
standard FormatDefineStyleChar dialog box.    Change anything you like.    You'll see a font 
preview in the bottom right corner.

Note that the style for the rest of the return address, "EnvAddresseeRest", is based on this
style.    If you want all line to be the same, you need only change the "EnvAddressee" style.

NOTE: If you've changed the "EnvAddresseeRest" style already, changing the 
"EnvAddressee" style may result in unexpected results.

NOTE: You do not need to choose the "Use As Default..." button.    Just click "OK".

See also

Preview Menu



Preview Font for Envelope Note
The Paragraph Style for the envelope note is "EnvNote".    Choose "Envelope Note" from the 
Preview Menu and you will be presented with the standard FormatDefineStyleChar dialog 
box.    Change anything you like.    You'll see a font preview in the bottom right corner.

NOTE: You do not need to choose the "Use As Default..." button.    Just click "OK".

See also

Preview Menu



Resizing the Logo
Choose "Resize Logo" from the Preview Menu to resize the logo in your envelope.

You can resize your logo to any size.    Just enter the width and height dimensions.    If you 
want to scale the logo equally in each dimension, leave one dimension blank.

To reset the logo back to its original size, click "Reset Size".

NOTE: Any changes you make to logos will reposition the return address and/or the logo.    
You may need to use the Preview Mode to make sure that the placements are to your liking.   
If you don't like it, move it.    No problem.

See also

Preview Menu



Printing the Envelope
To print the envelope from the Preview Mode, choose "Print Envelope" from the Preview 
Menu, "Print" from the "File" menu, or click on the Printer Icon in the Toolbar.

This takes slightly longer than normal print, because Enveloper needs to remove the 
envelope borders before sending it to the printer.    Keep an eye on the StatusBar for 
Enveloper's progress.

See also

Preview Menu



Returning to Preview
To remove the Preview Menu and return to Preview Mode, click the "Preview" button.

See also

Preview Menu



OK Button in Preview Mode
If you entered Preview Mode when Editing an Envelope, you will see the "OK" button.    Click 
it to return to the main envelope Setup dialog box.

There is NO difference between the "OK" button and the "Cancel" button.

See also

Preview Menu



Cancel Button in Preview Mode
If you entered Preview Mode when Editing an Envelope, you will see the "Cancel" button.    
Click it to return to the main envelope Setup dialog box.

There is NO difference between the "OK" button and the "Cancel" button.

See also

Preview Menu



Exiting Enveloper
If you entered Preview Mode when Running Enveloper, you will see the "Exit Enveloper" 
button.    Click it to Exit Enveloper and return to your document.

Be sure to print your envelope before exiting!

See also

Preview Menu



Returning to Enveloper
If you entered Preview Mode when Running Enveloper, you will see the "Return to Enveloper"
button.    Click it to run Enveloper again.

Be sure to print your envelope before returning to Enveloper, because you will lose all your 
changes!

See also

Preview Menu



Positioning Frames
Enveloper's default positioning for items is usually correct for most envelopes you might 
want to create, but there are always exceptions.    The elements that make up Enveloper, 
the addresses, logo's, notes, and the bar code can all be repositioned in the Preview Mode of
Enveloper.    The following steps outline the steps to repositioning the addressee 
information:

1. Locate the addressee information and click on the address once with the mouse.    
This should select the address so that a box appears around the address.

2. Now position the mouse cursor near the edge of the box so that the mouse cursor 
changes to a four-sided arrow.

3. Now, click and drag with the mouse to reposition the addressee.
4. You have now successfully moved a framed object in the Preview mode.    Once the 

positioning is satisfactory, click on the Envelope button on the Toolbar.
5. Choose the OK button in the resulting dialog to exit Preview with your changes intact 

(saved).

See also

Using Preview Mode



Exiting Preview
If you entered Preview Mode when Editing an Envelope, you will see the "OK" and 
"Cancel" buttons.    Click on either one to return to the main envelope Setup dialog
box.

There is NO difference between the "OK" button and the "Cancel" button.

If you entered Preview Mode when Running Enveloper, you will see the "Exit 
Enveloper" and "Return to Enveloper" buttons.

Click the "Exit Enveloper" button to Exit Enveloper and return to your document.

Click the "Return to Enveloper" button to run Enveloper again.

Be sure to print your envelope before exiting or returning to Enveloper, because you will 
lose all your changes!

See also

Using Preview Mode



Glossary

ATM
Face Side
Feed Side
Flap Side
Orientation
PFB
PFM
Reverse Landscape
Screen Font Resolution
SkipLines
SmartGrab
Status Bar
Toolbar
TrueType



Keyboard Shortcuts
You can jump to specific list/text boxes and Font Properties, and activate Command Buttons by using 
ALT+letter, where letter corresponds to the underlined letter for each box or button.



Trouble Shooting Guide
This section includes some common questions and answers concerning various topics.    You 
can look here first for answers.    For more detailed explanations, please refer to the manual 
or the ENVR4.DOC file.

Installation Questions
Addressee Grabbing
Return Address
Logo Problems
Bar code Questions
Envelope Printing Problems
Preview Mode
Envelope Feeder
Syntax Error Message



Questions: Installation
Q. If I have a HP LaserJet IIP with a PostScript cartridge, which installation option 

should I use?

A. If you have a PostScript cartridge, regardless of the actual printer, choose one of 
the installation icons marked for "PostScript".    The only thing you have to make 
sure of is that the feed characteristics (Flush Right or Centered) is correct for your 
printer.

Q. I have a PostScript printer, but it feeds with the flap on the left.    The icons on the 
installation page indicates flap on right for PostScript printers.    Should I change this?

A. You can, but it's not recommended.    Flap on the right means that we're printing 
Reverse Landscape.    This puts the return address at the leading edge of the 
envelope, minimizing smudging.    Note, however, that you may need to use Print 
Fields to get Reverse Landscape printing, depending on the version of Windows you 
have.    (This is automatically done at installation, but if you make changes later, you 
need to keep this in mind.)

Q. I have a LaserJet III series printer, but it feeds with the flap on the left.    The icons 
on the installation page indicates flap on right for III Series printers.    Should I 
change this?

A. This is essentially the same answer as is given above for PostScript printers, except 
that you always need special Print Fields to get Reverse Landscape printing.    This 
puts the return address at the leading edge of the envelope, minimizing smudging.    
(This is automatically done at installation, but if you make changes later, you need to 
keep this in mind.)

LaserJet III Series includes the IIID and the IIISi, but the IIIP is a separate choice.

See also

Trouble Shooting Guide



Questions: PostScript Cartridges
See Above (Installation Questions)



Questions: LaserJet III Series Printers
See Above (Installation Questions)



Questions: Dot-Matrix Printers
See Above (Installation Questions)



Questions: Grabbing Addressee
Q. Where did my NON-Breaking Hyphen go???

A. Well, Microsoft's Addressee Grab method apparently swallows nonbreaking hyphens 
(Ctrl+Shift+Hyphen).    You need to use SmartGrab.    Choose "Enveloper4 
Customize" from the "Tools" menu, click on "Set Global Defaults...", and select 
"SmartGrab".    Click "OK", and another "OK" to exit Customize.    Run Enveloper again,
and you should see your hyphen.

Q. Why isn't Enveloper grabbing my addresses?

A. Enveloper has several ways of grabbing the addressee.    None are fool proof, but try 
them out to see if any will work.    As a last resort, you can always highlight the 
addressee before clicking the Envelope Icon.

See also

Trouble Shooting Guide



Questions: Return Address
Q. I have two return addresses that I normally use.    Having to switch between them is a

pain, since editing envelope templates is so slow.    Is there a way to switch my return 
addresses dynamically at run-time?

A. There is, but you have to change the way you think about envelopes.    The way to get
what you want is to create two envelope templates, each with its own return address. 
You can think of these as computer models of preprinted envelopes.    You can 
customize each one to have different fonts also.    At run-time, simply choose the 
envelope template that corresponds to the return address you want.    It's fast.

Q. My return address is printing too far to the right.    It's about 1.5 inches from the left 
edge of the envelope.    What's wrong?

A. See the answer for Everthing Prints Too Far Right.

Q. My return address is printing too far to the left.    Half of it is getting cut off.    What's 
wrong?

A. See the answer for Everthing Prints Too Far Left.

See also

Trouble Shooting Guide



Questions: Multiple Return Addresses
See Above (Return Address Questions)



Questions: Return Address Position
See Above (Return Address Questions)



Questions: Logo Position
Q. Enveloper seems to have its own idea of where my logos go.    Is there any way I can 

change that?

A. Yes.    You can reposition the logo, or any item for that matter, in the Preview mode.    
Each envelope item is contained in a frame.    Just move the cursor to the edge of the 
frame until it turns to a four-headed arrow.    Then simply drag-and-drop the frame to 
a new location.    Be forewarned, however, that you may need to reposition the logo if 
you change its size or replace it.

See also

Trouble Shooting Guide



Questions: Postnet Bar codes
Most bar code questions fall in two categories: bar code fonts and bar code positioning.    See
the former if you're seeing only numbers on screen, or you like to change the type of fonts to
use for PostNet bar codes.    See the second topic if your fonts are missing, placed 
incorrectly, or are being cut off.

See also

Bar Code Fonts
Bar Code Positioning
Trouble Shooting Guide



Questions: Bar Code Font Installation
Q. I have installed Enveloper 4 without any of the custom bar code fonts and just 

purchased Adobe Type Manager (ATM), do I have to reinstall Enveloper?

A. No.    You can install the "Zip" font directly using ATM.    Just double-click on the ATM 
icon to invoke the ATM control panel and click the "Add..." button.    Change to the 
directory in which all the Enveloper 4 files are kept.    Choose the "Zip" font from the 
left box and click on "Add".    
If you have version 2.0 of ATM, you're done.    If you do not have a PostScript printer, 
you're done.    If you have version 1.x and a PostScript printer, then you also need to 
edit your WIN.INI file with NotePad:

1. Locate the printer sections by searching for lines that begin with "softfonts=".

2. Scroll down until you find a line that is similar to:
softfont6=c:\psfonts\pfm\zipn____.pfm

3. You need to add to that line the location of the outline (.pfb) font:
softfont6=c:\psfonts\pfm\zipn____.pfm,c:\psfonts\zipn____.pfb

4. Repeat for each section in your WIN.INI that contains "softfont" entries.

Q. I have installed Enveloper 4 without any of the custom bar code fonts.    I just got 
Windows3.1 and want to use the TrueType zip font to speed up bar code generation.    
Do I have to reinstall Enveloper?

A. No.    All you have to do is double-click on the Window's ControlPanel, the double-click
on Fonts, then click "Add...".    Go to the directory where your Enveloper 4 files are 
and you should see a list of fonts beginning with "Zip".    Choose "Zip (TrueType)".    
Voila!

Q. I have installed Enveloper 4 with the custom ATM bar code fonts.    I just got 
Windows3.1 and want to use the TrueType zip font instead.    Do I have to reinstall 
Enveloper?

A. No.    All you have to do is double-click on the Window's ControlPanel, the double-click
on Fonts, then click "Add...".    Go to the directory where your Enveloper 4 files are 
and you should see a list of fonts beginning with "Zip".    Choose "Zip (TrueType)".

Now invoke the ATM control panel (double-click on the icon).    Scroll to the bottom of 
the list.    Choose "Zip", then choose "Delete".    You may also have to remove the 
entries from your WIN.INI file.    Search for lines that look like:

softfont6=c:\psfonts\pfm\zipn____.pfm,c:\psfonts\zipn____.pfb

and delete it.    You also need to change the "softfonts=" entry.    If it originally reads 
"softfonts=6", you need to change it to "softfonts=5".    Note that you need to 
rearrange the fonts if the zip font is not the last one in the list.

See also

POSTNET Bar Code Fonts





Questions: Bar Code Missing or Cutoff
Q. I'm using an envelope printing format that aligns the envelope at the bottom edge of 

the page.    The problem is that the bar codes are getting cut off.    I tried moving it, 
but it always ends up in the same place.    How can I change this?

A. To protect against accidental moves, Enveloper resets the bar code position 
whenever you exit Preview mode.    This is because the bar code has to be in a fairly 
precise location, unlike the other items on the envelope.    To really move the bar 
codes, you need to edit your envelope template with "Enveloper4 Customize" from 
the "Tools" menu.    Choose "Printer Specific Settings..." and then "Barcode 
Position...".    Change the values and save your template.

Q. I'm using an Fit Page to Envelope mode for my envelopes to make my envelope 
feeder happy, but my bar codes are getting cut off at the bottom.    I tried moving it, 
but it always ends up in the same place.    How can I change this?

A. Some laser printers places restrictions on the printable area of a page, depending on 
the size of the page.    That limitation is cutting off the bottom of your bar codes.    You
need to move them by editing your envelope.    Choose "Enveloper4 Customize" from 
the "Tools" menu.    Choose "Printer Specific Settings..." and then "Barcode 
Position...".    Change the values and save your template.    Be sure to answer "Yes" if 
you want the change to apply to all newly created envelopes.

Q. When I try to Print/Merge to a document, the Document file that EnveloperMerge 
generates has "syntax errors" where the zip code should be.    Is that a bug?

A. No.    It means that you don't have screen fonts for the zip code activated.    If you're 
using ATM and you just installed Enveloper, you need to exit and rerun Windows 
before the font takes effect.    After merging, the merged envelope pages will contain 
the correct PostNet bar codes.    Note that the main envelope document used in the 
merge still has no bar codes.    There should be only two vertical bars bracketting 
some blank space.



Questions: Envelope Printing Problems
There are occasions when the envelope Previews correctly, but does not print correctly.    
Most of these are caused by incorrect setup of your envelopes.    Check one of the following if
it matches your problems.

Printer hangs or nothing is printed (usu. PostScript)
Addressee Prints at the top of the Envelope
Everything Prints Too Far to the Left
Everything Prints Too Far to the Right
Margin Errors When Printing

See also

Trouble Shooting Guide



Questions: Nothing Prints
Q. I have a PostScript printer.    Envelopes look OK in Preview mode, but nothing prints.    

What's wrong?

A. You probably chose the wrong Reverse Landscape print field codes.    To remedy this, 
edit your envelope templates by choosing "Enveloper4 Customize" from the "Tools" 
menu.    Highlight the envelope you want to fix and click "Edit".    Click "Print Field..." 
to see if there are any imbedded print fields.

If you're using Windows 3.0, choose "(none)", otherwise, choose "PostScript Reverse 
Landscape - Letter size".    Check the "Save as Default" box, then click "OK".    Choose 
"TestPrint" to see if the problem is fixed.    If it is, click "OK" to save the envelope.    If 
you are using Fit Page to Envelope, you need to select the corresponding PostScript 
Reverse Landscape code, i.e., "PostScript Reverse Landscape - Com10".

If not, try creating an envelope from scratch.

Q. I just turned on Fit Page to Envelope.    My envelope previews fine on screen, but a 
blank piece of paper comes out.    What do I do now?

A. You're most likely using a PostScript printer in Reverse Landscape mode (feeding face
up and flap on right,or face down and flap on left).    You are also probably using 
Windows 3.1.    This combination requires special Print Field Codes to enable Reverse 
Landscape printing.    

Unfortunately, the PostScript codes are dependent on the size of the page you're 
using to generate envelopes.    Switching from using a letter-sized page to Fit Page to 
Envelope for a Com 10 envelope, for example, requires you to change the Print Fields 
to the one tailored for a Com 10 page size.    See Printer Field Codes for more details.



Questions: Addressee Printing At Top
Q. When I print an envelope, the addressee prints near the top, where the return 

address should be.    What went wrong?

A. You probably tried to manually delete the return address when in the Preview Mode.    
This is not allowed, since it could screw up the bookmarks that Enveloper depends 
on for proper operation.    If you don't need a return address, use the "(blank)" return 
address when you edit the envelope template.
You need to create your envelope again.



Questions: Everything Prints Too Far Left
Q. Everything on my envelope is shifted to the left!    Half my return address is printed 

off the envelope!    Help!

A. You're using the incorrect Feeder Characteristicssetting for your envelope.    The 
solution depends on what type of printing you want to do.    Reverse Landscape is 
available to printers that interpres either PCL5 or PostScript.    It is recommended 
because it minimizes smudging by allowing the return address to print on the leading
edge.    Use the following table to determine the correct setting for your Feeder 
Characteristics settings.

If you use Reverse Landscape, you also have to make sure that the correct Printer 
Field Codes are used.    Hint: Try a test print after adjusting the Feeder Characteristics 
before looking at the Field Codes.

Reverse Landscape:

Face Up, Flap on Right, Center feed (or Flush right)
or Face Down, Flap on Left, Flush right (or Center feed)

Normal Landscape:

Face Up, Flap on Left, Center feed (or Flush right)
or Face Down, Flap on Right, Flush right (or Center feed)



Questions: Everything Prints Too Far Right
Q. Everything on my envelope is shifted to the rightt!    Half my return address is over 

1.5 inches from the left edge of the envelope!    Help!

A. You're using the incorrect Feeder Characteristicssetting for your envelope.    The 
solution depends on what type of printing you want to do.    Reverse Landscape is 
available to printers that interpres either PCL5 or PostScript.    It is recommended 
because it minimizes smudging by allowing the return address to print on the leading
edge.    Use the following table to determine the correct setting for your Feeder 
Characteristics settings.

If you use Reverse Landscape, you also have to make sure that the correct Printer 
Field Codes are used.    Hint: Try a test print after adjusting the Feeder Characteristics 
before looking at the Field Codes.

Reverse Landscape:

Face Up, Flap on Right, Center feed (or Flush right)
or Face Down, Flap on Left, Flush right (or Center feed)

Normal Landscape:

Face Up, Flap on Left, Center feed (or Flush right)
or Face Down, Flap on Right, Flush right (or Center feed)



Questions: Margin Errors When Printing
Q. I keep getting "Margins are set outside printable area" errors, but the envelope prints 

fine.    How can I get rid of these messages?

A. You need to adjust the standard margins that Enveloper 4 uses for its envelopes.    
The easiest way to determine the correct margin settings for your printer is to use the
Enveloper Preview mode and adjust the page margins (Format PageSetup) and 
printing until messages go away.    Concentrate on the top and right margins.    They 
are the usual culprits.

Take a note of the proper settings.    Click on the Envelope Icon and the "OK" to get 
back to the main Customize Setup dialog box.    Choose "Printer Specific Settings..." 
then "Minimum Margins..." and enter the new margin settings.    When you're done, 
Enveloper will ask if you want the new margins to apply to all newly created 
envelopes.



Questions: Preview Mode
Q. Everytime I go into the Preview mode, I get the dialog box that tells me to click on the

Envelope Icon to get the Preview mode Menu.    Can I prevent that box from 
appearing?

A. Yes.    Choose "Enveloper4 Customize" from the "Tools" menu to invoke the 
customization routine.    Choose "Set Global Defaults...".    In the "Preference Level" 
box, choose "Intermediate".    This will also prevent some other warning boxes from 
appearing, such as the one warning you to insert an envelope into the manual feed.

See also

Trouble Shooting Guide



Questions: Envelope Feeder
Q. I have an envelope feeder for my laser printer, but Enveloper ignores it....it tries to 

look for the Envelope Tray instead.    I've made sure that I changed Envelope Source 
from "Manual" to "Envelope", but that did not help.    What else can I do?

A. Did you check under the ToolsOptionsPrinter option for the Enveloper Feeder setting? 
Choose the "Tools" menu, click on Options, click on the "Print" icon.    If the setting for 
Envelope Feeder is grayed out, you need to update your printer driver.    In the 
meantime, you might try including the printer codes (to switch to the envelope 
feeder) directly into your envelope.    There are codes provided for PCL and PostScript 
printers.    (You may need to change them for your printer.)    Please refer to the 
documentation on PrintFields (page 28).

Q. I have a LJIIISi with an envelope feeder.    When using Enveloper 4, the printer driver 
keeps complaining that it can only print envelopes and refuses to print.    What's 
going on?

A. The printer driver in this case is being rather picky about what size the print media is.
Since Enveloper 4 creates its envelopes using a letter-sized paper, the printer driver
thinks you're trying to print paper with the enveloper feeder and kindly informs you 
that that is not allowed.
You need to edit your envelope template and choose the "Printer Specific Settings..." 
from the main Customize Setup dialog box.    Then choose "Fit Page to Envelope".    If 
you use the envelope feeder exclusively, answer "Yes" when asked whether you want 
this to apply to all newly created envelopes.

See also

Trouble Shooting Guide



Questions: Syntax Error?
Q. I see "!Syntax Error!Syntax Error" messages next to my bar codes.    What does that 

mean?

A. DO NOT PANIC!    This is normal.    You probably have either ShowAll or ShowHidden 
and DraftView enabled.    You may also see it in PrintPreview.    These messages will 
not print on your normal envelopes.    If it bothers you, turn off ShowAll or 
ShowHidden.

The Syntax Errors hide field codes that generate bar codes when you are using 
Enveloper Merge to Document.    These field codes do not make sense to Word for 
Windows until you merge, so it gives the errors.    These are normally hidden and 
should not affect normal Enveloper operation.

See also

Trouble Shooting Guide





ATM

Adobe Type Manager, a trademark of Adobe Systems Incorporated.    This is an on-the-fly bitmap-font 
generator for Windows applications.    Using Adobe's PostScript Type 1 font outline format, ATM generates
near-WYSIWYG bitmap fonts for the screen and non-PostScript printers.    ATM makes the large collection
of PostScript Type 1 fonts accessible to users who don't have PostScript printers, yet conserves precious 
hard-disk space by not generating and storing font bitmaps.



Face Side

This is either "Up" or "Down".    That is, does you envelope enter the printer face up or down?



Feed Side

This refers to how you feed your envelopes into the printer.    Depending on the printer, you feed it flush 
right, flush left, or centered.    Your printer documentation will tell you which way it expects to see 
envelopes.    When feeding envelopes manually, there is usually a guide to help you keep the envelope 
straight as you're feeding it to the printer.    Which side is that guide on?    That will give you a clue to the 
"Feed Side"



Flap Side

This refers to the envelope flap.    You know, the thing you lick.    Specifying the flap side helps us 
determine how the envelope is being fed into the printer.    When printing in Landscape mode, the 
envelope can be fed two ways.    One way is correct, the other way gives you an upside-down envelope.



Orientation

Either "Portrait" or "Landscape".    On laser printers, envelopes are usually printed with "Landscape" 
orientation.    On DeskJets and dot-matrix printers, "Portrait" is the norm.



PFB

PFB is the filename extension of a PostScript Type 1 font outline file.    ATM and PostScript printers use 
PFB files to create the actual characters that you see.    Enveloper ships with its custom Type 1 font for 
printing and displaying POSTNET bar codes (zipn____.pfb).    If you have ATM, Enveloper installation will
automatically copy this file to your ATM font outlines directory and update your ATM.INI file.



PFM

PFM is the filename extension of the printer metrics file.    For Type 1 fonts, ATM and PostScript printers 
use the information in this file to place characters on the screen and page.

The PFM file includes attributes such as the menu name, font name, bold/italic, pitch and family.    It also 
contains character widths and kerning information.

Enveloper ships with its custom Type 1 font for printing and displaying POSTNET bar codes 
(zipn____.pfm).    If you have ATM, Enveloper installation will automatically copy this file to your ATM font 
metrics directory and update your ATM.INI file.



Reverse Landscape

Reverse Landscape literally means an upside-down landscape page.    This capability is provided by HP's 
new PCL5 language that comes with the LaserJet III series printers.    PostScript printers have always had
this capability under Windows 3.0, but have changed for Windows 3.1.    Reverse Landscape really comes
in handy when printing envelopes on laser printers, because it allows the return address to be printed on 
the leading edge of the envelope, minimizing smudging

You may need special printer codes to convince your printer to do Reverse Landscape.



Screen Font Resolution

When you do not have ATM or another on-the-fly screen font generator, you need bitmapped screen fonts
in order for you to achieve WYSIWYG.    The resolution of the bitmap, however, depends on your video 
driver.    For example, standard VGA display drivers use 96 x 96 grid for its screen fonts.    8514/A drivers 
and some Super VGA drivers use a 120 x 120 grid.    Specifying the incorrect resolution may not have 
detrimental affects, but it will mean that your screen output may not match your printed output.

To find the default resolution for your video driver, run Control Panel from the Program Manager.    Double-
Click on Fonts.    If you have not manually changed any font settings, you'll see lines like:

Helv 8,10,12,14,18,24 (CGA res)
or

Helv 8,10,12,14,18,24 (VGA res)
or

Helv 8,10,12,14,18,24 (8514/A res)



SkipLines

If your letters always start about the same (e.g., logo, blank line, address, blank line, date), SkipLines can 
make your life much easier      you won't have to select the addressee before running Enveloper, plant a 
Bookmark, or worry about your mouse missing the last number of a ZIP code!    Count the number of lines
you usually have at the beginning of your letters, and use this as "SkipLines".    Play around until you get it
right    it'll save you gobs of time.    Leave the box blank to turn SkipLines OFF.



SmartGrab

SmarGrab follows a simple heuristic (Thanks Marc!): grab the first block of 3 or more left-justified, non-
blank text.    SmartGrab will search only the first 20 lines of your document, and it will not grab more than 
8 lines or 215 characters.    It works pretty well.    Is it foolproof?    No.    If you have a telephone number 
directly following your addressee, for example, it will be included.    But it's easier to delete an extra line or
two when you edit the addressee than it is to type in three or more, right?    Try it!    If you don't like it, you 
can turn it off by unchecking the box.



Status Bar

The Status Bar is a grey border at the bottom of your WinWord window.    It contains information such as 
the current page, section, cursor position on the current page, zoom factor, and the status of your 
NumLock and CapsLock keys.    If you do not see one, select "Options..." from the "Tools" menu.    Click 
on the "View" icon.    The 3rd checkbox toggles the Status Bar display.

Enveloper uses the status bar to keep you informed of its progress.    This can be useful during lengthy 
processing during installation.

Hint:    Double-Clicking on the Status Bar brings up the EditGoTo menu!



Toolbar

The Toolbar is a registered trademark of Microsoft Corporation.    It is a ribbon at the top of your WinWord 
window that contains icons that can speed up many WinWord operations.    If you don't see it, choose 
"View" from the the menu, then select "Toolbar".

Enveloper uses the envelope icon towards the right side of the Toolbar to invoke Enveloper and to call 
up the Preview Menu when in Preview Mode.



TrueType

TrueType is an on-the-fly bitmap-font generator for Windows applications.    It is available with Windows 
3.1.    Using the TrueType font outline format, Windows generates near-WYSIWYG bitmap fonts for the 
screen and all graphics printers.




